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Session outline

Part 1 – Introduction to Zotero & Installation

Part 2 – Collecting references

Part 3 - Creating bibliographies

Part 4  – Collaborating & other features

Part 5 – Any Questions?
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Reference management



Reference management software - Benefits

Staying organised

• Stores information about 
books and papers you may 
want to cite in one place

Saving time

• Formats your in-text 
citations, footnotes and 
bibliographies 

• Allows you to switch citation 
styles easily
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What does it do…

Collects & Stores 
your references   

Insert references into 
documents & create 

bibliographies

You can also:
• store full text articles 
and your own notes

• share references with 
others

Formats your references 
using your chosen citation 
style (and allows you to 
switch style easily)

Most databases allow 
you to send 
information directly to 
your reference 
manager (…no need for 
manual data entry)



Software options…

Reference management Libguide:
http://libguides.bodleian.ox.ac.uk/reference-management

http://libguides.bodleian.ox.ac.uk/reference-management


Zotero
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Zotero pros and cons

Pros
• Online and offline access to 

your Library from multiple 
devices

• Free for a basic account 

• Available for Windows, Mac 
and Linux

• Compatible with MS Word, 
Google Docs, Libre Office 
and Open Office

Cons
• Does not work with Pages

• Subscription required if you 
need to store more than 
300MB of data
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Zotero cloud storage

Cloud 

Storage
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Free or pay for account

Storage

• Up to 300 MG -Free

• 2 GB - $20 per year

• 6 GB - $60 per year

• Unlimited - $120  per year
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Installing Zotero



Installing Zotero – 3 components
1. Go to https://www.zotero.org/

download/

Choose “Zotero for Windows” (or Mac)
and  follow instructions. Save the file to your 
computer.  Once it has saved double click on the 
file icon and the follow on screen instructions.

2. Return to https://www.zotero.org/
download/

Choose one of the browser extensions e.g. Firefox, 
Chrome, Safari, Opera

3. You will also need to install the Word or Libre
Office plug in.  Open Zotero and choose  Edit / 
Preferences followed by Cite. Then choose the 
Word or LibreOffice plug-in as appropriate. 

https://www.zotero.org/download/
https://www.zotero.org/download/


Setting up a Zotero account

Setting up a Zotero account 
allows you to 

• backup

• access your Library on the web 

• synchronise between different 
computers and devices 

• Register at www.zotero.org
(top right)

http://www.zotero.org/


Linking Zotero with your account

Zotero Standalone

• Edit / Preferences / Sync – fill in your username and password



Task 1 – Setting up Zotero & creating an 
account

• Work through the installation instructions on the handout.    

• Handout available at: 
https://www.bodleian.ox.ac.uk/ask/workshops/reference-
management-workshop-handouts

• Ask if you need help

https://www.bodleian.ox.ac.uk/ask/workshops/reference-management-workshop-handouts


Part 2: Getting references 
into Zotero

Editing and organising references
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A quick tour of Zotero

Filter 

by tags

Navigate 

collections 

and groups

Toolbar and 

menus
List of documents in 

selected folder or library

Bibliographic information 

about the currently 

selected document 
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Options for adding references to Zotero

Data capture (databases, catalogues, web pages)

Add PDF files (Zotero will find matching bibliographic details for 
articles downloaded from databases)

Standard identifier (ISBN, DOI, etc.)

Manual entry

Import text files (.RIS/.BIB)
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To add items to Zotero from a 

results list in a database or 

catalogue

1. Click on the folder icon near to 

(or within) the address bar 

2. This will open a pop up menu 

listing all the items on the page

3. Tick the items you wish to add 

to Zotero and click OK

Web capture from databases/catalogues (e.g. Hist
Abs)
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Web capture from databases/catalogues (e.g. SOLO)

To add items to Zotero from a 

results list in a database or 

catalogue

1. Click on the folder icon near to 

(or within) the address bar 

2. This will open a drop down 

menu listing all the items on the 

page

3. Tick the items you wish to add 

to Zotero and click OK
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SOLO – Amendments to edited collections

Books added from library catalogues 

such as SOLO will always use the 

“author field”.  For edited collections 

change author to editor. 
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SOLO – amendments to book chapters

Change “Item Type” to “Book section”

Enter the chapter title by hand

Add the name of the chapter 

author(s).  Make sure that the book 

editor(s) are listed as editor(s)

Add page numbers
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Web capture: web pages

1. Open Zotero 

2. In your web browser, click on the page 

icon near to (or within) the address bar. 

Note if you are adding a book, journal 

article, video or newspaper article the 

icon will change appropriately (e.g. to a 

book, video etc icon) 

3. The item will be added to your Zotero 

Library. Zotero will also take a snapshot 

of the page
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Adding references by 
dragging and dropping 
PDF files

You can add references to Zotero by dragging 

and dropping PDFs into your Library.    Zotero 

will “find” matching bibliographic details for 

pdf journal articles downloaded from 

databases.  It will not find details for other 

PDFs (e.g. book chapters, reports and 

documents or photocopied/scanned items).

1. Drag a PDF from your computer into the 

centre column of Zotero.   (Make sure that 

you drop the pdf in-between items in your 

library rather than directly on top. If you 

drop the pdf on top it will be added to an 

existing reference!)

2. Find the pdf in your Zotero Library

3. Right click on it and choose “Retrieve 

Metadata for PDF”

4. Zotero will then find matching 

bibliographic details. 24



Adding a reference manually

Choose the correct 

reference type 

Fill in as much of 

the form as possible
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Adding a reference using ISBN, DOI or PMID
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Importing a RIS, BIB or TXT file

• Use for importing references from other reference managers 
(e.g. RefWorks, Endnote, Mendeley etc.)

• To import references from databases which do not work with the 
Zotero web capture tool

1. In the database/reference manager 
• Export items as a “RIS”,  “BIB” or “TXT” file  

• Save the file to your computer (e.g. to the downloads folder)

2. In Zotero
1. Click File / Import

2. Browse to find the RIS/BIB/TXT file that you saved to your computer.
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What are RIS and BIB files?

• An RIS or BIB file is a text file containing encoding that enables 
Zotero and other Reference Managers to read the data within:

Make sure you save the file 

as Type: Text File
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File -> Import will bring up the import wizard 
to upload the file from your computer
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Editing references

Select the item
Click in any field 

to edit

Add personal notes

Add tags

Arrow indicates more 

than one file is 

available for the 

entry e.g.  Personal 

notes; full text PDF; 

web snapshot.
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Organising references

You can create Collections (like folders) 
and/or use Tags

Collections allow you to organise your 
references hierarchically e.g. by project 
or essay. 

Tags allow you to form ad-hoc 
collections after adding items to your 
library
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Deduplicating references

Select “duplicate 
references” on the left 
sidebar

On the right side, 
Zotero will give you the 
option to select a 
“master” reference and 
merge the duplicate 
references



Switching off automatic tag import

◼ By default, Zotero 
imports tags from 
Library catalogues and 
databases

◼ Switch this off from the 
toolbar in Edit / 
Preferences
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Searching your library

◼ You can search for documents in your Zotero
library

◼ You can also filter your records within a folder

◼ You can add your own tags to records to make 
them easier to find
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Task 2 – Adding & organising 
references

• Follow the steps on the hand-out

• Handout available at: 
https://www.bodleian.ox.ac.uk/ask/workshops/refere
nce-management-workshop-handouts

• Add some references to Zotero

• Organise them using collections and tags
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https://www.bodleian.ox.ac.uk/ask/workshops/reference-management-workshop-handouts


Part 3: Creating bibliographies

• Adding in-text citations & footnotes

• Inserting bibliographies and changing 
citation styles
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Add citations to documents
◼ For essays/papers – use the Word or Libre 

Office/Open Office plug in. To install from:
◼ Windows: Edit > Preferences > Cite.

◼ Mac: Tools > Add-ons.

◼ Alternatively you can drag and drop references from 
Zotero into Word, email etc.
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Inserting citations in Word
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1. Click Zotero

3.  Search for the appropriate 
reference by typing a keyword (e.g. 
author name, title keyword)

4.  Alternatively, click on the Z to 
switch to Classic view (where you 
can browse your collections) to find 
references 

2. Click Add/Edit Citation. The first 
time you do this you will be 
prompted to choose a citation style



Adding page numbers etc. to citations

Click on the citation. This 
will open up a dialogue 
where you can add pages 
numbers, prefix, suffix etc.
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Adding a bibliography in Word
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Switch citation style – document preference

Insert list of cited items; add items to the bibliography which you have not cited; remove items 
which you have cited. You can also use edit to change the formatting of individual items. 
However, if you do this, the item will no longer be updated when you make changes to your 
Zotero Library.



Creating a bibliography in Zotero

1. RIGHT click on a folder

2. Choose ‘Create Bibliography from Collection’. You will be 
prompted to choose a citation style and to save the 
bibliography to your computer
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Getting more citation styles

• Download more citation styles from zotero.org/styles

• Right-click on a citation style of your choice and select Save link to 
download the style.

• Makes sure Zotero Standalone is running. Then double-click the 
downloaded file to install the new style.
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https://www.zotero.org/styles


Editing a style

• Web based style editor - http://editor.citationstyles.org/about/

• Not easy but can be done
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http://editor.citationstyles.org/about/


Part 4: Other Features

• Synchronising 

• Zotero Groups
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Your Zotero account

• Access and sync your library from anywhere (and from multiple 
computers)

• Create and join groups to share collections

• Access and share files in addition to references (but beware of 
copyright restrictions)
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Syncing your library

• Connect Zotero to your account by following the steps under 1B on 
the handout

• Synchronise your account by clicking the sync icon 
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How to stop PDF files syncing to your online 
account 
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From the Zotero homepage click on 
Edit – Preferences – Sync 

Untick Sync full-text content to help 
prevent reaching your free online 
Zotero storage limits.



Sharing references with 
others
• Collaborators must have a  Zotero 

account

• Set up groups and define access rights 
on the Zotero web site 
https://www.zotero.org/groups/

• Add and organise references for your 
groups in Zotero Standalone

• Don’t forget to Sync after 
adding/editing references

Groups
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https://www.zotero.org/groups/


Backing up your references

• Back up your references regularly

• Save to external hard drive or cloud storage (OneDrive)

• Instructions: https://www.zotero.org/support/zotero_data
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https://www.zotero.org/support/zotero_data


Getting Help

◼ zotero.org/support

◼ Local managing references guide:

◼ http://libguides.bodleian.ox.ac.uk/reference-management

◼ Email the Bodleian Libraries reference management team: 
reference-management@bodleian.ox.ac.uk
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https://www.zotero.org/support/
http://libguides.bodleian.ox.ac.uk/reference-management
mailto:reference-management@bodleian.ox.ac.uk

